
Documents for a Purpose 1

Learning Objectives

Student is able to:
Pass/ 
Merit

1
Create and format text which is suitable 
for a particular purpose

P

2
Adjust properties to allow graphics or 
other objects to fi t well within the 
document

P

3 Insert table into document P

4 Use advanced formatting features M

5 Use page formatting options M

6
Adjust page formatting for a specifi c 
audience

M

Module 1 
Documents for a Purpose
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2 Documents for a Purpose

Learning Objective: 11.1 Formatting text

Who will be reading? 

 Before you format your text, think of the
audiences who will be reading it.

 	How do you attract them to read?
 	How do you make your text more 

 appealing to them?
 Consider the audiences according to:

 	age
 	occupation
 	background
 	 interest.
 Vary the format by changing:

 	font styles
 	text sizes
 	colours
 	 images.

 Children will like:
 	colourful text
 	 little text
 	simple colour graphics or illustrations
 	easy-to-read font style
 	big text size.
 Young people are more concerned with:

 	moderate font size
 	stylish font style
 	colours
 	attractive illustrations.
 Older people may prefer:

 	big text size
 	simple font style
 	useful and relevant illustrations.

Typing and formatting text

 Type the following article.
 Use spell-checker to check for spelling errors.
 Proofread to ensure the whole text is typed correctly.
 Save it in your folder as launchingcis.

Launching of Cambridge ICT Starters in Mukah, Sarawak, Malaysia. 

The Information and Communication Technology (ICT) programme at 

SK Dato Awang Udin in Mukah, Sarawak, Malaysia was launched by 

former Prime Minister Tun Dr Mahathir Mohamad on 10 April 2004. 

The ICT programme, which will witness the introduction of ‘Cambridge 

ICT Starters’ for students at the school, marks yet another important 

milestone for the spread of ICT education to rural schools, especially in the coastal belt. The ICT programme 

is a pilot project for Mukah and the coastal area, and is an extension of an earlier successful pilot project 

which was launched at SK Datu Pengiran Mohamad, Oya, another rural area, by Sarawak Chief Minister 

Pehin Sri Dr Haji Abdul Taib Mahmud in 2001. The ICT project will complement the Government’s efforts in 

bridging the digital divide between the rural and urban areas and eradicating rural poverty. Describing the 

ICT education project as an important enabler in promoting IT-assisted learning, the company’s managing 

director, Kuintan Sepawi, said, “We like to consider our contribution from the private sector as one which 

is supportive of the Government’s k-economy initiative, which seeks to move Malaysians away from physical 

resources towards knowledge-based resources.” On the Cambridge ICT project, she said it highlighted the 
various critical components necessary in creating a sustainable ICT-focused education programme.
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Documents for a Purpose 3

Changing font

 Open the fi le launchingcis.

 Find out what the default font of your word 
processor is.

 Hold  and tap  simultaneously.

 If the default font is Calibri, then change the 
font of the text to Times New Roman; 
otherwise change the font of the whole 
passage to Calibri.

 Calibri or Times New Roman are two very 
common fonts that are easily accepted by 
most audiences.

Changing font size

 Find out what the default font size of your word processor is. 

 Hold  and tap  simultaneously.

 If the default font size is 11, change it to a bigger size of 14.

 Now try to change the font size to 16. 

 Change the font size back to 11. 

 Font size 11 is a very common font size and is suitable for 
adults. 

 Children and older audiences may prefer the bigger font size 
of 16 or even 18.

Text alignment

 Place the cursor anywhere in the text.

 Click , the text will be aligned at the 
centre.

 Titles are usually aligned at the centre.

 Click , the text will be left aligned. If the 
page width or column width is limited, left 
alignment is a better choice.

 Click , the text will be right aligned. 
Date and page number are commonly 
right aligned.

 Click , the text will be justifi ed. Justifi ed 
text looks neat and professional.

 You may wish to select a different font. 
Whatever font you have chosen, make 
sure it is suitable for your audience.

Centre aligned Right aligned

Left aligned Justifi ed

Launching of Cambridge ICT Starters in Mukah, Sarawak, Malaysia. The Information 
and Communication Technology (ICT) programme at SK Dato Awang Udin 

in Mukah, Sarawak, Malaysia was launched by former Prime Minister Tun Dr 
Mahathir Mohamad on 10 April 2004. The ICT programme, which will witness 

the introduction of ‘Cambridge ICT Starters’ for students at the school, marks yet 
another important milestone for the spread of ICT education to rural schools, 
especially in the coastal belt. The ICT programme is a pilot project for Mukah 
and the coastal area, and is an extension of an earlier successful pilot project 
which was launched at SK Datu Pengiran Mohamad, Oya, another rural area, 

by Sarawak Chief Minister Pehin Sri Dr Haji Abdul Taib Mahmud in 2001. The ICT 
project will complement the Government’s efforts in bridging the digital divide 

between the rural and urban areas and eradicating rural poverty. Describing the 
ICT education project as an important enabler in promoting IT-assisted learning, 

the company’s managing director, Kuintan Sepawi, said, “We like to consider 
our contribution from the private sector as one which is supportive of the 

Government’s k-economy initiative, which seeks to move Malaysians away from 
physical resources towards knowledge-based resources.” On the Cambridge 

ICT project, she said it highlighted the various critical components necessary in 
creating a sustainable ICT-focused education programme.

Launching of Cambridge ICT Starters in Mukah, Sarawak, Malaysia. The 
Information and Communication Technology (ICT) programme at SK Dato Awang 
Udin in Mukah, Sarawak, Malaysia was launched by former Prime Minister Tun 
Dr Mahathir Mohamad on 10 April 2004. The ICT programme, which will witness 
the introduction of ‘Cambridge ICT Starters’ for students at the school, marks yet 
another important milestone for the spread of ICT education to rural schools, 
especially in the coastal belt. The ICT programme is a pilot project for Mukah 
and the coastal area, and is an extension of an earlier successful pilot project 
which was launched at SK Datu Pengiran Mohamad, Oya, another rural area, 
by Sarawak Chief Minister Pehin Sri Dr Haji Abdul Taib Mahmud in 2001. The ICT 
project will complement the Government’s efforts in bridging the digital divide 
between the rural and urban areas and eradicating rural poverty. Describing the 
ICT education project as an important enabler in promoting IT-assisted learning, 
the company’s managing director, Kuintan Sepawi, said, “We like to consider 
our contribution from the private sector as one which is supportive of the 
Government’s k-economy initiative, which seeks to move Malaysians away from 
physical resources towards knowledge-based resources.” On the Cambridge 
ICT project, she said it highlighted the various critical components necessary in 
creating a sustainable ICT-focused education programme.

Launching of Cambridge ICT Starters in Mukah, Sarawak, Malaysia. The Information 
and Communication Technology (ICT) programme at SK Dato Awang Udin 

in Mukah, Sarawak, Malaysia was launched by former Prime Minister Tun Dr 
Mahathir Mohamad on 10 April 2004. The ICT programme, which will witness 

the introduction of ‘Cambridge ICT Starters’ for students at the school, marks yet 
another important milestone for the spread of ICT education to rural schools, 
especially in the coastal belt. The ICT programme is a pilot project for Mukah 

and the coastal area, and is an extension of an earlier successful pilot project 
which was launched at SK Datu Pengiran Mohamad, Oya, another rural area, 

by Sarawak Chief Minister Pehin Sri Dr Haji Abdul Taib Mahmud in 2001. The ICT 
project will complement the Government’s efforts in bridging the digital divide 

between the rural and urban areas and eradicating rural poverty. Describing the 
ICT education project as an important enabler in promoting IT-assisted learning, 

the company’s managing director, Kuintan Sepawi, said, “We like to consider 
our contribution from the private sector as one which is supportive of the 

Government’s k-economy initiative, which seeks to move Malaysians away from 
physical resources towards knowledge-based resources.” On the Cambridge 

ICT project, she said it highlighted the various critical components necessary in 
creating a sustainable ICT-focused education programme.

Launching of Cambridge ICT Starters in Mukah, Sarawak, Malaysia. The Information 
and Communication Technology (ICT) programme at SK Dato Awang Udin 
in Mukah, Sarawak, Malaysia was launched by former Prime Minister Tun Dr 
Mahathir Mohamad on 10 April 2004. The ICT programme, which will witness 
the introduction of ‘Cambridge ICT Starters’ for students at the school, marks yet 
another important milestone for the spread of ICT education to rural schools, 
especially in the coastal belt. The ICT programme is a pilot project for Mukah 
and the coastal area, and is an extension of an earlier successful pilot project 
which was launched at SK Datu Pengiran Mohamad, Oya, another rural area, 
by Sarawak Chief Minister Pehin Sri Dr Haji Abdul Taib Mahmud in 2001. The ICT 
project will complement the Government’s efforts in bridging the digital divide 
between the rural and urban areas and eradicating rural poverty. Describing the 
ICT education project as an important enabler in promoting IT-assisted learning, 
the company’s managing director, Kuintan Sepawi, said, “We like to consider 
our contribution from the private sector as one which is supportive of the 
Government’s k-economy initiative, which seeks to move Malaysians away from 
physical resources towards knowledge-based resources.” On the Cambridge 
ICT project, she said it highlighted the various critical components necessary in 
creating a sustainable ICT-focused education programme.

Choose the 
font from 
the list.

Learning Objective: 1

Choose the 
suitable font 
size here.

www.cambridge.org© in this web service Cambridge University Press

Cambridge University Press
978-1-107-62519-8 - Cambridge ICT Starters: On Track: Stage 1: Third Edition
Jill Jesson and Graham Peacock
Excerpt
More information

http://www.cambridge.org/9781107625198
http://www.cambridge.org
http://www.cambridge.org


4 Documents for a Purpose

Formatting the title

 First align all the text as Justify.
 The fi rst line can be taken as the title of the 

story.
 Place the cursor at the end of the fi rst line, 

to the right of the full stop.

 Tap 
Backspace

 once to remove the full stop.

 Tap Enter  twice to separate the title from 
the rest of the text.

 Place the cursor anywhere within the title.

Another paragraph

 Identify the fourth sentence of the newly 
formed second paragraph: ‘Describing the 
ICT education project undertaken ...’

 Place the cursor to the left-hand side of the 
fi rst word: ‘Describing’ .

 Tap Enter  twice.
 This will create a new paragraph and insert 

a new line above the new paragraph.

 Tap Backspace .
 This will remove the blank line if you have 

not typed anything on it.

Break the text into paragraphs.

 Highlight the whole text and change the
font size of the body text to 12. 

 The body text is too long and therefore 
difficult to read.

 We can break the text into a few paragraphs.
 Each paragraph should discuss one main 

point.
 Place the cursor on the left of the fi rst word

of the text: ‘The’ .

 You may tap Tab  once to insert an
indent to the fi rst paragraph, but this is
not necessary.

 Identify the third sentence:
 ‘The ICT programme is a pilot project...’

 Click  to make the title centre aligned. 
 Highlight the title. 

 Click  to make the title bold. 
 Click  to underline the title. 
 Change the font size of the title to 14. 
 Change the font style of the title to 

Century Gothic or any legible font. 
 Change the font colour to red.
 Click  to save the fi le using the same 

fi lename.

 Tap Enter  again to insert a blank line 
above the third paragraph.

 You may tap Tab  to insert an indent
for the third paragraph.

 Click  to save the fi le using the same 
fi lename.

 Click , hover over  to 
see .

 Place the cursor on the left-hand side of the 
fi rst word of the third sentence: 

 ‘The’ .

 Tap Enter  once.
 This breaks the third sentence from the 

second sentence.

 Tap Enter  again.
 This will insert a blank line.

 Tap Tab  to insert an indent for the 
second paragraph.

 Click  to save the fi le using the same 
fi lename.

Click  to preview what 
your document looks like.

1.2 Paragraph break Learning Objective: 1

www.cambridge.org© in this web service Cambridge University Press

Cambridge University Press
978-1-107-62519-8 - Cambridge ICT Starters: On Track: Stage 1: Third Edition
Jill Jesson and Graham Peacock
Excerpt
More information

http://www.cambridge.org/9781107625198
http://www.cambridge.org
http://www.cambridge.org


Documents for a Purpose 5

Learning Objectives: 1, 21.3 Inserting images

More formatting

 Locate and highlight the school name ‘SK 
Dato Awang Udin’ in the fi rst paragraph.

 Change the colour to deep blue.

 Locate the following names and change 
their colour to deep blue:

 	Tun Dr Mahathir Mohamad

 	Pehin Sri Dr Haji Abdul Taib Mahmud

 	Kuintan Sepawi

 Locate ‘Cambridge ICT Starters’ in the fi rst 
paragraph and change its colour to red.

 Click  to save the fi le using the same 
fi lename.

Drag diagonally to 
enlarge or reduce 
the image.

Launching of Cambridge ICT Starters in Mukah, Sarawak, Malaysia. 
The Information and Communication Technology (ICT) programme at SK 

Dato Awang Udin in Mukah, Sarawak, Malaysia was launched by former Prime 
Minister Tun Dr Mahathir Mohamad on 10 April 2004. The ICT programme, which 
will witness the introduction of ‘Cambridge ICT Starters’ for students at the school, 
marks yet another important milestone for the spread of ICT education to rural 
schools, especially in the coastal belt. 

The ICT programme is a pilot project for Mukah and the coastal area, and 
is an extension of an earlier successful pilot project which was launched at SK 
Datu Pengiran Mohamad, Oya, another rural area, by Sarawak Chief Minister 
Pehin Sri Dr Haji Abdul Taib Mahmud in 2001. The ICT project will complement the 
governments efforts in bridging the digital divide between the rural and urban areas 
and eradicating rural poverty.

Describing the ICT education project as an important enabler in promoting 
IT-assisted learning, the company’s managing director, Kuintan Sepawi, said, “We 
like to consider our contribution from the private sector as one which is supportive 
of the Government’s k-economy initiative, which seeks to move Malaysians away 
from physical resources towards knowledge based resources.” On the Cambridge 
ICT project, she said it highlighted the various critical components necessary in 
creating a sustainable ICT-focused education programme. 

Moving the image

 Click anywhere on the image. 
 Once the image is selected, the Format tab

is displayed. 
 Click .
 Try out the different text-wrapping properties 

one by one to see the effect on the text
around the image. 

 Finally, choose square as the text-wrapping 
property.

 Place the cursor anywhere inside the 
image.

 The shape of the cursor changes to  .

 Drag to move the image to a new position.

Inserting images

 A relevant image often explains the meaning 
better than words.

 Click on Insert tab.

 Click .

 Select the image drmahathir.jpg.

 The image will be inserted at the position of 
the cursor.

 You can move the image or resize it.

 Place the cursor at one of the four corners.

 The shape of the cursor changes to .
Drag it inward to reduce or outward to 
enlarge the image.
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6 Documents for a Purpose

Learning Objectives: 1, 2

More images

 Click on Insert tab.

 Click .

 Select the image oya.jpg. 

 Resize, change text wrapping to square and 
place it somewhere in the second paragraph. 

 Insert another image pic2.jpg, resize, change 
text wrapping to square and place it somewhere 
in the third paragraph.

 Click  to save the fi le using the same fi lename. 

 Close the fi le.

World’s Longest Bridge Spans

 Click  to start a new document.

 Type the following heading:
World’s Longest Bridge Spans

 Change the font style to Times New Roman.

 Change the text size to 24.

 Align the title at the centre .

 Add the following text: 
Longest Bridge Spans are categorised in the 
following tables according to the structural 
type of the main span. The ‘span’ means the 
main span of a bridge = centre-to-centre 

Inserting a table

 Make sure the cursor is placed at the end 
of the document you have just typed.

 Tap Enter   twice.

 Type 1. Suspension Bridges 

 Click on Insert tab.

 Click .

 Click .

 In the dialogue box, change the number of 
columns to 6 and the number of rows to 2.

distance of adjacent towers, pylons, piers 
or supports given in metres. It does not 
mean the total length or overall length of 
multi-span bridges. Overall lengths are not 
included - only the longest spans. ‘Year’ 
means the year of completion or intended 
completion if known.

 Set the font size to 12. 

 Set the alignment to Justify . 

 Save as longestbridge in your own fi le 
folder.

Launching of Cambridge ICT Starters in Mukah, Sarawak, Malaysia. 
The Information and Communication 
Technology (ICT) programme at SK Dato 
Awang Udin in Mukah, Sarawak, Malaysia 
was launched by former Prime Minister 
Tun Dr Mahathir Mohamad on 10 April 
2004. The ICT programme, which will 
witness the introduction of ‘Cambridge 
ICT Starters’ for students at the school, 
marks yet another important milestone 
for the spread of ICT education to rural 

schools, especially in the coastal belt. 

The ICT programme is a pilot project for 
Mukah and the coastal area, and is an 
extension of an earlier successful pilot 
project which was launched at SK Datu 
Pengiran Mohamad, Oya, another rural 
area, by Sarawak Chief Minister Pehin 
Sri Dr Haji Abdul Taib Mahmud in 2001. 
The ICT project will complement the 
Government’s efforts in bridging the digital 
divide between the rural and urban areas and eradicating rural poverty.

Describing the ICT education project as an important enabler in promoting IT-
assisted learning, the company’s managing director, Kuintan Sepawi, said, “We 
like to consider our contribution from the private sector as one which is supportive 
of the Government’s k-economy initiative, which seeks to move Malaysians away 
from physical r e s o u r c e s 
t o w a r d s k n o w l e d g e 
b a s e d resources.” 
On the Ca m b r i d g e 
ICT project, she said it 
h ighl ighted the various 
c r i t i c a l components 
n e c e s s a r y in creating a 
sustainable ICT-focused 
e d u c a t i o n programme.
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Documents for a Purpose 7

Learning Objective: 31.4 Tables

Typing in the tables

 Type the heading of each column.

 Tap Tab  to move to the next column.

 When you reach the last cell, tapping Tab  again will insert a new row.

No. Bridge Span (m) Location Country Year

 Adjust the column width by dragging the border of the column.
 Place the cursor on the border until it changes its shape to .
 Hold down the mouse and drag to the left or to the right to resize the column.
 Complete the table so that it looks like the sample below:

 1. Suspension Bridges

No. Bridge Span (m) Location Country Year

1 Akashi-Kaikyo 1991 Kobe-Awaji Japan 1998

2 Xiahoumen Bridge 1650 Zhoushan Archipelago China 2009

3 Great Belt East 1624 Hasskov-Sprogo Denmark 1998

4 Yi-Sun-Sin 1545 Gwangyang-Yeosu South Korea 2012

5 Runyang South 1490 Yangtze River China 2005

More tables

 Add the following two tables: 
 2. Cable-Stayed Bridges

No. Bridge Span (m) Location Country Year
1 Russky 1104 Eastern Bosphorous Strait Russia 2012
2 Sutong 1088 Suzhou-Nantong China 2008
3 Stonecutters 1018 Rambler Channel Hong Kong 2009
4 E-dong 926 Huangshi China 2010
5 Tatara 890 Seto Inland Sea Japan 1999

 3. Steel Arch Bridges

No. Bridge Span (m) Location Country Year

1 Chaotianmen 552 Chongqing China 2009

2 Lupu 550 Shanghai China 2003
3 New River Gorge 518 Fayetteville,WV USA 1977
4 Bayonne 504 New York USA 1931
5 Sydney Harbour 503 Sydney Australia 1932

 Click  to save the fi le.
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8 Documents for a Purpose

Learning Objective: 41.5 Numbering and bullets

Numbering

 Click  to start a new blank document.
 Type the following text:

Everybody likes to blow out the candles on the birthday cake during his or her birthday party. 
Candles create a special atmosphere on this special occasion. Candles are handy too when 
there is power failure.

Treat the candles well; they bring you joy and happiness. Treat them carelessly; they bring fi re 
into your home!

Here are some guidelines on candle safety:

Double-check they’re out when you do not need them.
Keep clothes and hair away from them.
Keep children and pets away.
Put them on a heat-resistant surface.
Put them in a proper holder.
Keep them away from infl ammable materials like curtains.
Take care with votive or scented candles.
Use a snuffer or a spoon to put them out.
Don’t put them under shelves.
Don’t move them when they’re burning.
Don’t leave them burning while you are out.
Don’t keep candles too close to each other.

Formatting

 Save the document you have just typed in 
your folder as: candlesafety. 

 Read through the document once again 
carefully to ensure that you did not miss out 
any words.

 Use a spell-checker to check for spelling 
errors.

 Click  to save the document again if you 
have made any changes. 

 Insert a title for the document: CANDLE 
SAFETY.

 Set the font for the title to Arial. 

 Set the font size to 16. 

 Make the title bold. 

 Set the alignment to centre .

 Highlight the guidelines starting from 
‘Double-check they’re out when you do not 
need them.’ up to the end of the document.

 Click .

 Notice that all the guidelines will be 
numbered from 1 downwards.

 Click  again. 

 The numbering has disappeared. 

 Now click .

 Instead of numbering, the guidelines are 
listed one by one after a bullet.

 Clicking  again will toggle off the bullets 
format.
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Documents for a Purpose 9

Learning Objective: 4

Formatting numbering

 Instead of numbering the guidelines 1, 2, 3, 
4, ... etc., we can change the format to A, B, 
C, ... .

 Highlight the guidelines again.

 On the Home tab, click on  beside .

 Click on one of the styles listed.

 You can repeat the commands for a different 
style.

 Click  and save your work before you proceed.

Formatting bullets

 As with numbering, bullets can be changed.

 Highlight all the guidelines.

 On the Home tab, click on  beside .

 Click on the styles of bullet of your choice.

 Repeat the commands to see the effect of different
bullets.

 Click  to save the document.

Customised bullets

 Click on  beside .

 Click on .

 Click  and select a font of your choice, 
click .

 Click  and select a new character of your 
choice, click .

 Click  if you prefer to have different 
pictures as bullets, click .

 You can try out the text position, indent, tab space 
and so on, as well.

 Click  when you have fi nished.
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10 Documents for a Purpose

CANDLE SAFETY

Everybody likes to brow the candles on the birthday cake during your birthday. Candles create a 
special atmosphere on this special occasion. Candles are handy too when there is power failure.

Treat the candles well; they being you joy and happiness. Treat them carelessly; they bring fi re into 
your home!

 • Double-check they’re out when you do not need them

 • Keep clothes and hair away

 • Keep children and pets away

 • Put them on a heat resistant surface

 • Put them in a proper holder

 • Put them away from infl ammable materials like curtains

 • Take care with votive or scented candles

 • Use a snuffer or a spoon to put them out

 • Don’t put them under shelves

 • Don’t move them when they’re burning

 • Don’t leave them burning while you are out

 • Don’t keep candles too close to each other

CANDLE SAFETY

Everybody likes to brow the candles on the birthday cake during your 
birthday. Candles create a special atmosphere on this special occasion. 
Candles are handy too when there is power failure.

Treat the candles well; they being you joy and happiness. Treat them 
carelessly; they bring fi re into your home!

 • Double-check they’re out when you do not need them

 • Keep clothes and hair away

 • Keep children and pets away

 • Put them on a heat resistant surface

 • Put them in a proper holder

 • Put them away from infl ammable materials like curtains

 • Take care with votive or scented candles

 • Use a snuffer or a spoon to put them out

 • Don’t put them under shelves

 • Don’t move them when they’re burning

 • Don’t leave them burning while you are out

 • Don’t keep candles too close to each other

Learning Objective: 51.6 Page setup

Margins

 The blank space outside the printing area 
on a page is called the margin.

 Click on Page Layout tab.

 Click  and click the icons in turn to 
see how they affect your text.

 Click . Click  to increase 
or  to decrease the top, botom, left or 
right margin.

 The bigger the number, the bigger the 
margin.

 Always do a preview before you print. 

Paper size

 You must also check the size of the paper 
that you will be using.

 Click on Page Layout tab.

 Click .

 Check the paper size.

 If you are using single sheet, select the 
most common size, A4, from the list of 
sizes.

 If you are using continuous computer 
paper, select letter.

 Always do a preview before you print.

This is Portrait 
orientation. This is 

Landscape 
orientation.

Page orientation

 Click  to open the fi le candlesafety.

 Click on Page Layout tab.

 Click  .

 Under Orientation, click .

 Click on View tab, click  to see what 
Landscape Orientation looks like.

 Repeat for Portrait orientation: .

 Click on View tab, click  to see what 
Portrait orientation looks like.
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